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This Tutorial will show us how to do both a raster and cutout using GPL free software along with our 
Lasersaur hardware adapted to a K40 laser.   All software is free and provided for no charge on our 
CD-ROM and automatically setup with the automated installers inside windows.  By running the 
appropriate installer for your Windows operating system on the included CD-ROM with purchase, you 
will automatically have the graphical editor Inkscape, the 305 rastering script for Inkscape, the drivers 
for the hardware,  along with the Lasersaur software and program shortcuts installed all at once.  This 
manual assumes you have ran this installer script.  Please note that for Linux users will will have to 
possibly use the FOSS/synaptic/application installer to setup Inkscape, but we have still created an 
automated shell script to do the rest of installation for Linux Mint and Linux Ubuntu on the same CD 
installer.

One further note that our software REQUIRES FIREFOX as the default operating system browser be 
installed.  The Lasersaur does not work on Internet Explorer or Edge, if you use those for your default 
browsers.  You're responsible outside of the automated mentioned installer above of making sure you 
have downloaded and installed the free Firefox from Mozilla organization (free GPL software) plus 
making it your default browser for opening any web page.  This is required because Lasersaur 
application uses the browser to communicate to the Lasersaur hardware.

Before we go much further I think it important we discuss the power and implementation of raster 
scanning versus vector tracing/cutting.  It so turns out that Lasersaur does both with a clean workflow 
using our installed applications, whereas Moshi standard only does rastering.  So let's discuss what a 
raster scanned image is?

Before we go further with this tutorial we need to understand vectoring versus raster scanning. Raster 
scanning  is commonly how images were formed on old CRT televisions.  That is each horizontal line 
of pixels was beam scanned one line at a time left to right before advancing downward one line and 
again sweeping left to right.  In this way with rastering the line by line a pixelated version of an image 
is reproduced.  Please see how the big box old TV's created an image based on a raster by the following
pictorial diagram. Obviously the beam only turns on in a particular position of the scan if that particular
pixel is wanted to be activated as on. The Moshi laser controller when rastering an image as an 
engraver does much the same thing as the old CRT  TV tubes, that is it makes multiple passes and only 
turns on one dot of the image on any one horizontal line scan at a time.  That is great for image 
engraving, but it terrible if we want to cut out around the same outline or shape perimeter:
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So with vectoring which is much more powerful for cutting through an object instead of going line by 
line scan we will instead follow point by point along our perimeter contour.  So a vector scanning 
CRT/laser would do this instead, kind of like connecting the dots consecutively along the perimeter.  
Not only on a laser does a vector cut mean no diagonal offset like in raster scanning, but it means that 
by slowing the beam speed on a outer perimeter we can effectively increase the laser intensity with less
power to actual laser tube being consumed.  A life saver in laser tubes by using less power, but also 
increasing the speed of the cutout as well:

Now that we can see the advantages to both raster scanning  and vectoring for both image engraving 
and cutting respectively we are going to wed them together with the easy flow of Inkscape and the 
Lasersaur software.

Starting this exercise by using our installed graphical Inkscape application.  We will first add two layers
inside a new Inkscape document.  On the first layer we call “LaserCut” we will  create a path to cut 
around our bitmap rastered image on the “LaserCut” layer.  Then we will create another layer called the
“raster” layer which will contain our graphical image we want to raster pixels.   The nice thing about 
layers is we can have either two layers visible or mutually one or the other layers on, this is nice of 
course as when we make the image or “raster” layer invisible then create a vector file for the visible 
layers one by one.  And since raster scanning and vectoring put out two different files types we need to 
be able to shut each respective layer off when saving the outputs to later be pulled in one at a time as 
layers inside Lasersaur application, which means we can also assign different feed-rates and pulse 
width modulated power intensities for both layers independent of one another.  



First open up a New Document inside Inkscape then click on Add Layer as shown below:

We are going to give the new layer the name “raster”, and click Add:



Now since we just added the raster layer it will also be the active layer.  So let's import the graphical 
file in this case a money.png file by File->Import in the pulldown along with the radial choice of 
“embed”.  

After we import the image in the “raster” layer we can then move and scale (or keep same) the image 



inside the page work application boundaries.  The final result of the inkscape import will look like 
below:

Now we are going to add the boundary outline perimeter layer called the “LaserCut” layer:

Since the “LaserCut” as our last added layer is now the active layer we can begin to trace around the 
image with lines and Bezier curves tool to represent where we want the laser to cut around the object.  
The tool is on the side pane of Inkscape as shown below:



And using the Bezier Curves and Lines we have nearly traced around the money that we want the laser 
to cut,  the trace path or “Lasercut” path is in light green.  To complete the Laser cut path we just need 
to left mouse click one more time where the square connection endpoint to startpoint is located:

We are next going to need to turn the visibility of each layer on and off we do this by accessing the 
layer dialog control:



When the layer dialog/pane comes up make visible (open eye) the “LaserCut” Layer and invisible the 
“Raster” Layer (close eye) as shown.  This will obviously hide the money image while only showing 
our laser cutting outline.

We will convert these lines and curves to vectors by using the Inkscape object to path function as 
demonstrated below:



So we are near complete with the vectors required to cut the perimeter of our item, we just need to use 
the file pulldowns File->Save As and then make sure that “Plain SVG” is the file extension type to 
select.  And of course give this file a good name as we will be pulling them into Lasersaur browser 
application to perimeter vector cut control.

We are now going to generate our raster scan for the engraving file for the money picture.  So with that 
said we are going to start by making visible the “Raster” layer (open eye) and hiding the “LaserCut” 
layer (closed eye).  If you need to remember how to turn on the layer dialog/pane just go to the 
pulldown Layer->Layers..  which is the last submenu item in the Layer pull down.



We are now going to convert this image into a raster scan by using the 305 engineering raster extension
in Inkscape:

So when the 305 Gcode generator dialog is brought up it's important to note that two parameters are 
absolutely critical.  One is that the Flip Y is checked, if not then the image scan will appear at the 
bottom (sometimes off the table) of the Laser Table and upside down.  The second most important 
attribute is to set it to the highest resolution 10 pixels/mm otherwise it will be grainy and terrible raster 
quality.  Obviously as you get more experience you can play with the other setting on the raster scan 
extension.  You'll have to obviously provide the directory and file name you want to create.  In this case
we are going to save the laser engraving raster as MoneyRasterScan in the Desktop directory.  It's our 
observation that the directory is usually preserved after the first usage from that point on it remembers 
that as the default location, but be sure you specify this or else your .ngc might be in places of an 
unknown location.

 



What's been achieved?

After clicking apply from the last step we have generated a raster file name 
“MoneyRasterScan_0001_Bwfix_128_gcode.ngc” and a vector file for cutting around the raster with a 
file name of “rollcut.svg”.  Both of these files are placed on our computer desktop or location where 
saved them, and now both can be imported into Lasersaur and be assigned properties such as feed rate 
speeds and pulse width modulation percentage.  The coordinates and scales will be the same.  We are 
now going to run the Lasersaur Application and load these files.

Start Lasersaur and Load the rastering and cutout vector files

We need to start the Lasersaur application.  After running the installer on the CD you should have a 
shortcut (looks like a mini-dinosaur) icon on your Desktop.  You'll go ahead and use that shortcut for 
the Lasersaur to start the application.  In a short while you'll see the Lasersaur front end application 
open a browser with the laser controls inside.  Next hit the CONNECT button to turn it green:

After successfully connecting the button will change to green “Ready”:

Next we need to home the laser so that the image will appear in it proper location, thus it needs to have 
the zero coordinate calibrated by clicking on the button below that looks like a little monopoly home.

On the left hand side of the Lasersaur application click on the File import tab:



Let's bring up the File import dialog by clicking on the import button:

Obviously we want to load the raster first before we do the cutout outline so we are going to import and
run it by selecting the Money_Raster.ngc file created by the 305 extension in our previous exercises.

After clicking on the open button in image above we will see our raster scan item appear in the 
Lasersaur engraving/cutting workspace.



Next we click on the 'Add to Queue' button:

And now the Lasersaur browser workspace will show the parameters to set the feed-rates shown as “F” 
and pulse width modulation (PWM) percentages shown as “%”.  Let's take a moment to reflect how all 
this works along with the hardware controller and your Laser?  So how it works is that on your K40 
you are able to set the maximum current (power) using the modulation potentiometer dial.  When you 
push the momentary fire/test switch you bypass all the controller and will have the full power to the 
laser for the setting.  In Lasersaur full power would be the same as the test/fire switch  if set to 100 (%),
which is obviously the second field right to the “%” label below.  We usually recommend that the user 
set the laser power 8-10mA with the test/fire hardware switch and variable potentiometer dial.  Now 
10mA is usually enough power to cut through say acrylic with the right feed-rate.  But obviously we 
are running a raster scan where we simply want to etch and not cut.  So in this case we have set the 
power to 30% which would be equivalent to 30/100 x 10 mA= .3 x 10 mA = 3 ma of full power 
through a test/fire and potentiometer dial setting.  In this case PWM stands for pulse width modulation 
of full power, which is saying we are only going to allow the full power to be fully on 3 tenths (.3) of 
ever second (1 second), the rest the time of that period duration will be off.  Now obviously we are 
going to also have to set the feed-rate so that it isn't running too fast (meaning that it barely has tine to 
score and etch) and not too slow where it effectively cuts deeper with little laser power.  We set it to 
1500 mm/min for this example.  Obviously you will play with this setting for your material that needs 
etched.  Finally we sent the raster scan to begin laser etching by clicking on “Send to Lasersaur” 
button.  Notice you only have to deal with Pass 1 and not 2 and 3 because we are not using Lasersaur's 
multiple pass with different colors meaning different power/feed-rates tags in the document.  These 
tags can be implemented but we see no practical value added for a majority of projects as we simply 
want to either etch or cut with the same parametric feed-rate and PWM%.  Still for the enterprising 
person that finds a usage one can visit Lasersaur's information about using tags if so desired.

After completing the etch, we now want to now perform the cutout.  So we are going to use our second 
developed vector file we created from the Inkscape preceding tutorial section ( rollcut.svg). So again 
click the “File Import” tab and button. 



We will now upload the “rollcut.svg” vector file we generated earlier in our part of tutorial to cut the 
perimeter of our scanned raster from last step into Lasersaur:

The imported vector file appears inside the Lasaur Application as below.

We next left mouse button click the “Add to Queue” Button.



The last step to begin the laser to cutting out the border perimeter is to set the feed-rate  and PWM 
power to 100% and then click on the “Send to Lasersaur” button.  Notice we use a much slower 
feed-rate (300mm/min) and the maximum output power (100%), both these will help thoroughly 
increase the cutting depth say like to acrylic.  You'll have to adjust both of these for the type of material
and thickness through empirical trial and error.

Conclusion:

We have shown in this tutorial to both generate plain.svg vector files to cutout perimeter outlines as 
well as generate raster scans for images.  Both files were then imported into our Lasersaur application.  
The solution is clean and simple work flow.


